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Introduction

Scope of this quick guide
In this quick guide, you will learn how to properly setup a ZEISS eXtended Data (XD) setup and get an understanding
of the new metadata workflow:

You will learn how to connect the CP.3 XD lens to camera (ARRI and RED) and MasterLockitPlus recorder.
You will learn how to record ZEISS eXtended Data into the MasterLockitPlus.

You will learn how to preview distortion and shading corrected images on set using the XD technology.
You will learn how to prepare recorded eXtended Data and transfer them to post-production.

You will learn how to apply correction in Blackmagic Design DaVinci Resolve using recorded eXtended Data
and the ZEISS eXtended Data plug-in.

What is ZEISS eXtended Data?
ZEISS extended Data is a newly developed lens data technology. It is based on the Cooke /& Technology which
provides frame-accurate key lens data about:

Lens name, type and focal length

Calibrated focusing distance

Calibrated T-stop value

Depth-of-field data in real time and hyperfocal distance
Horizontal field-of-view

Entrance pupil position

ZEISS eXtended Data extends the functionality with additional ZEISS specific lens data about:
The characteristics are calculated frame accurate in real time for every focal point and effective T-stop.

The key lens data are transferred either directly to the camera through a 4-pin Cooke /i interface (PL mount) and / or
to any supported equipment via external plug. ZEISS specific lens data is currently only recorded by the
MasterLockitPlus. In the future, cameras will also be able to record the specific lens data.

* /iis a registered trademark of Cook Optics Limited uses with permission
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Recording ZEISS eXtended Data via external LEMO®™ compatible plug Recording ZEISS eXtended Data via internal camera interface
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via external LEMO®~ compatible plug to Ambient MasterLockitPlus via PL-mount interface to Camera

transfer per integrated WiFi AP transfer/recording options: embedded in video files or as sidecar file

= data management on set with Pomfort Silverstack = data management on set with Pomfort Silverstack

= live grading on set with Pomfort LiveGrade Pro

l

implementation of ZEISS specific data with ZEISS plug-in for common implementation of ZEISS specific data with ZEISS plug-in for common
post-production tools post-production tools

* LEMO is a registered trademark of INTERLEMO HOLDING S.A.



Overview of the equipment

ZEISS CP.3 XD lens
Camera
Ambient MasterLockitPlus
Cables
= Lens data cable
= Power cables
= Camera metadata cable
= Timecode cable
Apple iMac, MacBook or MacBook Pro with macOS 10.10 or newer
(is called Mac in the following pages)
PC computer (optional)
Blackmagic Design UltraStudio Mini Recorder or similar recording device

®  Thunderbolt cable

=  HDMI or SDI cable
Software

®  Pomfort LiveGrade Pro (version 3.9 or later)

®  Pomfort Silverstack XT or Silverstack Lab (version 6.2 or later)
= Blackmagic Design DaVinci Resolve (version 12.5 or later)

= Blackmagic Desktop Video drivers



ZEISS CP.3 XD lens

The ZEISS CP.3 XD lenses offer the perfect combination of high image quality and reliable usability. They exhibit the
clean, crisp characteristics ZEISS is known for, together with an interchangeable mount system and full-frame
coverage. CP.3 XD lenses are compatible with a wider range of cameras and mount types than any other cine lens
on the market.
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1. Rear lens element 5. External socket

2. Lens mount (Female 4-Pin mechanical connector)
3. Aperture ring 6. Focus ring

4. Aperture index mark 7. Focus index mark

8. Front lens element

For further information, please visit https://www.zeiss.com/camera-lenses/int/cinematography/products/compact-
prime-cp3-lenses.html.


https://www.zeiss.com/camera-lenses/int/cinematography/products/compact-prime-cp3-lenses.html
https://www.zeiss.com/camera-lenses/int/cinematography/products/compact-prime-cp3-lenses.html

Ambient MasterLockitPlus

e The MasterLockitPlus by Ambient Recording is part of a timecode system.
e [t generates timecode on set, in order to synchronize multiple cameras and audio devices.
e |treads ZEISS eXtended Data out of the CP.3 XD external socket.

e |t records ZEISS eXtended Data internally and / or passes it through via WiFi / Ethernet to Pomfort LiveGrade
Pro for live preview on set.

1
7
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9
5 MasterLockitrus 0
© acN
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1. Ethernet port 7. Antenna port (ANT) with antenna
2. DCin port 8. Blue ACN port for camera metadata
3. 2x USB port; for WiFi adapter stream
4. Display 9. Red TC port for timecode
5. Navigation switch / Power button 10. Grey ACN port for lens data
6. Status LED 11. 1/4 " thread mount

For further information please visit http://ambient.de/product/mlp/.


http://ambient.de/product/mlp/

— Camera metadata cable
ACN-RCP
for RED

Timecode cable

TC-10 and TC-IO-RA

for ARRI Alexa Series and

REDCOLT Expander

LTC-Out/EPIC

for RED DSMCT and DSMC2 Expander
(excl. REDVOLT)

LTC-OUT

for ARRI Amira, Blackmagic,

MasterLockit — Canon, Sony ...
(@Y B

Camera metadata cable
MLC-L1B10
MLC-L1B10P

for ARRI Alexa Classic

Lens data cable
MLC-CP
for CP.3 XD lenses

The following table shows, which cables you need for your specific camera setup. You will need all cables to
successfully prepare a proper metadata setup. You can find a detailed view of every cable in the Appendix.

included with
. camera
ARRI ALEXA Classic MLC-CP TC-10 MLC-L1B10P
metadata
cable
ARRI ALEXA Classic MLC-CP TC-10 MLC-L1B10 AK-LOB2-HS4
€0 included with
. . camera
ARRI ALEXA Mini MLC-CP (optional MLC-L1B10P
metadata
TC-10-RA)
cable
AK-LOB2-HS4
ARRI SXT MLC-CP TC-10 - or
MLC-L1B10P
ARRI Amira MLC-CP LTC-OUT = AK-HS4
Blackmagic o
: Ursa/Mini/Mini Pro MLC-CP LTC-Out - AK-XLR4M
Design
AK-HS4-PC2M
Canon C700 MLC-CP LTC-Out = (AK-LOB2-HS4
optional)
Canon C500 MLC-CP LTC-Out - -
Canon C300 I MLC-CP LTC-Out - -

! The camera metadata cable is not necessary to get the ZEISS eXtended Data but is part of a correct metadata setup with the

MasterLockitPlus. Using this cable, the MasterLockitPlus receives metadata from the camera in addition to the ZEISS eXtended

Data. The MasterLockitP/us dos not support all cameras.

2 Cameras with no or not supported power outlet require additional 6-28V power source to power the MasterLockitP/us / CP.3
XD connection. Different solutions are possible.



Canon

Panasonic

Panasonic

Panavision

RED

RED

RED

RED

RED

RED

RED

Sony

Sony

Sony

C100 11

Varicam LT/35/HS

Varicam Pure

Milenium DXL

DSMCT

DSMC2 w Base
Expander

DSMC2 w V-LOCK I/0
Expander
DSMC2 w JETPACK
Expander

DSMC2 w JETPACK-
SDI Expander

DSMC2 with REDVOLT
Expander

DSMC2 w OMOD

F65

F5/F55

FS7I1I (requires XDCA-
FS7 for timecode and
DC out)

MLC-CP

MLC-CP

MLC-CP

MLC-CP

MLC-CP

MLC-CP

MLC-CP

MLC-CP

MLC-CP

MLC-CP

MLC-CP

MLC-CP

MLC-CP

MLC-CP

TC-OUT

LTC-Out

LTC-Out

over ACN

LTC-Out/
EPIC

LTC-Out/
EPIC

LTC-Out/
EPIC

LTC-Out/
EPIC

LTC-Out/
EPIC

TC-10

over ACN

LTC-Out

LTC-Out

LTC-Out

over ACN

ACN-RCP

ACN-RCP

ACN-RCP

ACN-RCP

ACN-RCP

ACN-RCP

over ACN

AK-HS4
(AK-LOB2-HS4
optional for
35/HS)

AK-LOB2-HS4

AK-LOB2-HS4

AK-HS4-PC2M

AK-LOB2-HS4

AK-LOB2-HS4

AK-LOB2-HS4

AK-HS4

AK-HS4



ZEISS eXtended Data setup

Hardware setup
The MasterLockitPlus, the camera and the CP.3 XD lens need to be plugged-in carefully. The setup depends on the
type of camera in use.

Recording of ZEISS eXtended Data via the CP.3 XD external plug with the Ambient Recording MasterLockitPlus is
possible with any camera which has the possibility to get a timecode connection to the MasterLockitPlus.

You will find the correct Timecode cable for your camera on the Ambient Recording webpage
(http://ambient.de/product_custom_cat/timecode-kabel/). Also you need the lens data cable MLC-CP for the
connection CP.3 XD lens and MasterLockitPlus and a 6-28V power source for the MasterLockitPlus.

In this guide, we describe the setup for ARRI cameras with PL mount and Cooke /i 4-pin interface and RED DSMC2
cameras.

General procedure for connecting the equipment
No matter what camera is in use, always proceed in this order:
= Connect the MasterLockitPlus to the camera using timecode and camera metadata cable.
= Connect the MasterLockitPlus power cable.
= Switch on the camera.
= Switch on the MasterLockitP/us.

Once the system is up and running, you can proceed with the lens setup in the following order:
= Attach the lens to the PL mount.
= Connect the lens to the MasterLockitPlus.

Exchanging the lens
Camera and MasterLockitPlus are running and should not be switched off.
Always proceed in the following order:

= Disconnect the lens from the MasterLockitPlus.

= Detach the lens from the camera.

= Attach the new lens to the camera.

= Connect the new lens to the MasterLockitPlus.

Warning

If you do not proceed in the order described above (eg. connect the lens to MasterLockitP/us before attaching the
lens), the lens might not be recognized by the MasterLockitPlus or by the camera.

In this case, unplug the lens from the MasterLockitPlus and plug it to the MasterLockitP/us again.


http://ambient.de/product_custom_cat/timecode-kabel/

ZEISS eXtended Data setup with ARRI Alexa, Alexa XT / SXT and Alexa Mini

Equipment
=  ARRI Alexa, Alexa XT / SXT, Alexa Mini
= ZEISSCP.3 XD
= MasterLockitPlus
= Lens data cable MLC-CP
= Timecode cable TC I/0
= Camera metadata & power cable MLC-L1B10P

Camera — MasterLockitPlus connection

Camera ‘ Cable ‘ MasterLockitPlus
Timecode connector < TC-10 -> | TC (red)
Ethernet connector < MLC-L1B10P - | Ethernet port + DC in

Lens — MasterLockitPlus connection
Lens ‘ Cable ‘ MasterLockitPlus

External socket ‘ < MLC-CP > ‘ ACN (grey)

I i
: AMB‘Ew '




ZEISS eXtended Data setup with RED Scarlet-W, Epic, Epic-W, Weapon

Equipment
= RED Scarlet-W, Epic, Epic-W, Weapon
= ZEISSCP.3 XD
= MasterLockitPlus
= Lens data cable MLC-CP
= Timecode cable LTC-Out/EPIC
= Camera metadata cable ACN-RCP
= Power cable AK-HS4-PC2M

Camera — MasterLockitP/lus connection

Camera Cable ‘ MasterLockitPlus
Sync & LTC-Out/EPIC - | TC (red)
Ctrl < ACN-RCP - | ACN (blue)
Power TAP < AK-HS4-PC2M - | DCin
Lens — MasterLockitPlus connection
Lens | Cable | MasterLockitPlus
External socket ’ & MLC-CP > ‘ ACN (grey)




Read or record key lens data on the camera

Cameras with PL mount including Cooke /i 4-pins connector allow viewing and recording standard lens data in the
camera body.
Depending on cameras capabilities, only part of lens data will be recorded.

How to check if the lens is recognized by the camera

ARRI Alexa Mini

To get live lens data on display in the ARRI Alexa Mini, click on Info = Lens info in the display.
Push the M Button on top of the viewfinder to toggle view of the viewfinder.

Version info
System info

Maximum FPS info

CARD info
USB info
Network info

ARRI Alexa SXT / Alexa Plus
To get lens data on display in the ARRI Alexa SXT / Alexa Plus, push the button WRS => Lens Data on the camera.
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RED Scarlet-W, EPIC, EPIC-W, Weapon
To get live lens data in the RED Scarlet-w, EPIC, EPIC-W or Weapon, check if the lens is recognized:

e Settings = Setup = Lens
e Switch between Info and Metadata

Meladata

Lens: Name

Lens: Serial Number.

You get live lens data on the display:

23 98Frs 150800 : 5600k Menu

Focal Length: 35mm AE:Continuous in Preview

Focus Dist.: 39cm - 41cm

01:43:20:08

A004_CO019 1/5-50
DC2/RG4 N 37°/58° $-SSD RB cn
Cal: TIE 87% 96%

23.98rPs Drop:0

In case the lens data is not shown on the screen, in the viewfinder or in the camera menu:

= Disconnect the lens from the MasterLockitPlus.

= Detach the lens from the camera.

= Attach the lens to the camera.

= Wait until the lens data is shown on the monitor.
= Connect new lens to the MasterLockitP/us.



Read or record ZEISS eXtended Data on the MasterLockitPlus

In order to record ZEISS eXtended Data the MasterLockitPlus must be setup correctly:
= Camera, MasterLockitPlus and lens are connected according to your camera setup
= Camera is up and running
» MasterLockitPlus is up and running

Connect the MasterLockitPlus to a computer
While no connection to the computer is needed during the shot, it makes sense to use the web interface of the

MasterLockitPlus during setup to ensure that all parameters are correct.

via WiFi
The WiFi dongle must be connected to one of the MasterLockitPlus’s USB ports.
= Open your network settings and search for WiFi Access Points.
= Connect to the access point which name (SSID) begins with “mlp-".
»= Type in the password. The password is identical to the name of the access point (mlp-...).

via Ethernet
= Connect the Ethernet cable to your MasterLockitPlus.

= Connect the Ethernet cable to your Computer or Laptop.

Access the MasterLockitP/us web interface
» Open a web browser (we recommend Google Chrome).
= Typein 10.0.0.1 OR masterlockit.local in the address bar.

In case the web interface does not appear, verify that the MasterLockitPlus is properly connected to your computer
via WiFi or Ethernet.

Synchronize MasterLockitPlus and camera
While the MasterLockitPlus records the ZEISS eXtended Data continuously, it is important to ensure that the

timecode and the Frame Rate are setup correctly and synchronized with the camera.

For ARRI and RED cameras: To set the timecode in your camera, connect your camera with the timecode cable with
the MasterLockitP/us. Go to the timecode settings in your camera menu and chose the following settings:

ARRI cameras:
= TC - Options
Source: Ext LTC
Mode: Free Run
Generator: Regen

RED cameras:
» Menu - Settings - Project > Frame Rate
Project Time Base: select your Frame Rate, for example 23,98 FPS
» Menu - Settings = Project - Timecode
TC Display Mode: TOD
Source: External

13



Choose the right Frame Rate in the web interface of the MasterLockitP/us and click Set Time of Day. The camera gets
the timecode from the MasterLockitP/us now.

Frame Rate (FPS)

E—
Mode
Slave
ACN Channel
18 (&
o c
Userbits.
o o
Word Clock.
Tune s
1 @A
Warning

In case of wrong setup, the ZEISS eXtended Data cannot be applied on clip data in post-production.
* Ensure that the system date and time of the camera are correct. Using a wrong date and time might prevent
you to match ZEISS eXtended Data to video clips.
= Verify that the timecode value on the web browser (TC) corresponds to the timecode value on the camera.
» Ensure that the Frame Rate (FPS) value on the MasterLockitP/us is similar to the Frame Rate setup in the
camera.

Verify that the lens and camera are connected to the MasterLockitPlus
Click on the ACN Radar tab.

Elements with green background are recognized by the MasterLockitP/us.

T 00,01 & o
TC: 09:01:22:20 -]

ACN Radar

¥ 100% (Linn) | 23F

Other Lockits in ACN Channel 18

No devices detected. Please make sure that il Lockits are in the same ACN channel.

v6.1 @ Amb

Lens connection
CP.3 XD objectives will be automatically detected by the MasterLockitPlus.

In case the lens is not recognized:
= Verify that the MLP-CP cable is plugged in correctly.
= Un-plug and re-plug the MLP-CP cable.
= Verify that the whole connections have been done correctly.



Camera connection
The MasterLockitPlus is able to read metadata from RED and ARRI Alexa cameras. If you use such a camera, it is

good to have a connection for metadata between MasterLockitPus and camera. To get those connection please
following the next steps.

Preparing the camera

RED cameras:
» On the camera go to Menu - Settings - Setup - Communication - Serial.
* Choose Red Link from the list.

ARRI cameras: No preparation is needed.

Adding the camera
Click on Add Device and add your camera

= RED cameras: Choose a name and click on Save device.
» ARRI Cameras: Choose a name and type in your 4-Digit ARRI Alexa Serial Number and click on Save Device
(You can find the serial number on a sticker on your camera or by pushing the info button and then the

version button on your ARRI Alexa).
» |n case another camera is already recognized, click on Switch device and add your camera.

ACN Radar

W Local MasterLockit %100 % [Lilon) | 23F

z il
B000.0803:87:£74F:00

© switch Device

15



Preview lens correction on set using LiveGrade Pro

External cable

Video stream
) » Re
LiveGrade &
|: | /A
[ seeee- .|

""""" Distortion and shading
corrected image
(on set image enhancement)

eXtended Data stream

What is Pomfort LiveGrade Pro?

LiveGrade Pro is a Mac software, developed by Pomfort GmbH, which allows to live preview color graded image on
set, starting from software version 3.9. It gets live stream from the camera over SDI of HDMI and shows the color
graded image either on a Mac display or on a DOP / DIT monitor connected to the Mac.

LiveGrade Pro includes a feature that allows to preview lens correction on the live image.

Install Pomfort LiveGrade Pro

Download LiveGrade Pro (http://pomfort.com/livegradepro/)

Copy LiveGrade Pro to your applications folder and start it.

Activate LiveGrade Pro (license):

= Open the License Manager by choosing Licenses... from the LiveGrade Pro menu.
LiveGrade... = Licenses...

® (Click on Add License... in the opening License Manager.

= Type or copy / paste a valid license key.

= Click on Activate License.

License can be ordered from Pomfort web site.

In order to activate the license, the computer must have access to internet.

Connect the camera to your Mac
Equipment needed:

Camera with HDMI or SDI output

HDMI or SDI cable

Blackmagic Design Ultra Studio Mini Recorder
Mac

USB-C to Thunderbolt adapter

Thunderbolt cable


http://pomfort.com/livegradepro/

Install and setup Blackmagic Design video drivers

=  Download the latest Blackmagic Desktop Video drivers:
https://www.blackmagicdesign.com/support/family/capture-and-playback
= Choose “Download Only” to download and install the Blackmagic Desktop Video drivers.
Setup:

Connect the BMD Mini Recorder to your Mac via the Thunderbolt cable.
= (Click on the apple icon.

= (lick on System Preferences.
= (Click on the BMD Desktop Video icon.

System Preferen

Mission
Control

Desktop & Dock
Screen Saver

g a @ f

Language  Security  Spotlight Notifications
&Region &

= g N &
. - \ "=
Displays Energy Keyboard Mouse Trackpad Printers & Sound Startup
s @ © @ © @
iCloud Internet App Store Network Bluetooth Extensions Sh 9
n - @® @
A & @
Touch ID Users & Parental Siri Date & Time Time Accessibility
Groups Controls Machi

Blackmagic
Deskt...video

= (Click on the button that is in the center of the Desktop Video Utility.
Desktop Video Setup
UltraStudio Mini Recorder
(;j»
]

Select the video feed source (HDMI / SDI) you'll be using.
= Uncheck the box next to 1080PsF On.

ene

Blackmagic Deskiop Video Setup

UltraStudio Mini Recor...

UltraStudio Mini Recorder

and 2« Captured as 1080 progressive video

O Coptured s 1080PsF sagmencad e
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https://www.blackmagicdesign.com/support/family/capture-and-playback

= Click on Conversions.
= Set the Input conversion dropdown to None.
= (Click Save.

®0® Blackmagic Desktop Video Setup

UltraStudio Mini Recor. w
UltraStudio Mini Recorder

Conversions  About

Connection to Mac with USB-C connector
Camera SDI / HDMI > Blackmagic Design Ultra Studio Mini Recorder = Thunderbolt / USB-C converter = Mac

Connection to Mac with Thunderbolt
Camera SDI / HDMI = Blackmagic Design Ultra Studio Mini Recorder - Mac

Get live feed from camera in Pomfort LiveGrade Pro

Pre-requisites
= Camera is connected to Mac using the Blackmagic Design Ultra Studio Mini Recorder.
= Blackmagic Design Video Drivers are installed and working.

» LiveGrade Pro is up and running.

Steps
= (Click on Device = Add Device... = Add Capture Device...

@ LiveGrade File Edit Project LIl View Window Help
> Manage Devices...

= [ No HDLinks connecte:
Framegrab Refresh Devices No ISMini

7 = | Add Pluto..
Folders Permanently Store Looks on Devices X {+#S Add FSI Device

Permanently Store Selected Look on > Add Teradek Device.

Folder Create date E |
ACES 14/07/2015 Switch to Previous Slot %<  Add OMOD Device...
Log-to-Video  14/07/2015 Lo Switch to Next Slot s>  Add Canon Monitor...

| Add Alexa SXT...
Sample Looks  14/07/2015 Switch to Previous Look Node \38<  Add Varicam...

Switch to Next Look Node 88> Add Sony F65...
Add CDL Server...
Panasonic Viog Default Add Lockit...

Add Capture Device...

Canon C-Log Default 14 Jul 20.5, 03:43

ARRI Alexa Log-C Default 14 Jul 2015, 03:43

Freestyle



= A new window opens

UltraStudio Mini Recorder

If the preview image stays black although the settings seem correct,
consider (un)checking the "Use 1080p not 1080PsF" checkbox in the
Blackmagic System Preferences.

Video Format: 1080p25
Capture Source: () direct camera output
LUT box output (graded)
? Cancel O Add N
' - - X

If the screen of the UltraStudio Mini Recorder is black, then unplug it and plug it back in.

= Select UltraStudio Mini Recorder.
= Under Capture Source select direct camera output.
= (Click on Add.

Setup Pomfort LiveGrade Pro to receive ZEISS eXtended Data
Pre-requisites
» MasterLockitPlus is connected to the lens and camera correctly.
» MasterLockitPlus is connected via WiFi or Ethernet to the Mac.
= Lensis connected and recognized by the MasterLockitPlus.

= (lick on Device = Add Device... = Add Lockit...

& LiveGrade File Edit Project ol View Window Help

[=1 Sample Project

Permanently Store Looks on Devices @3S
Permanently Store Selected Lock on >

Switch to Previous Slot x<

Switch to Next Slot *>
, | Add Alexa SXT...

Add Varicam...
Add Sony FE5...

= A new window opens.

The IP: masterlockit.local should appear in the IP Address bar.
© Window

Lockit Device

IP Address: masterlockit.local

Disconnected

7 Add Lockit Device_*

= (lick on Add Lockit Device.
19



= Lockit must appear on the bottom left corner without warning sign.

Devices.. *= O Look CDLandLUT

v

o3 (o (o
. 13-./“ »

UltraStudio Mini Recorder

No LUT loaded
| Lockit N
N\

Neutral Reset Colors ©® Graded @ Bypass 1 Original

Preview shading and distortion correction in Pomfort LiveGrade Pro
= Click on Window -> Lens correction controls

@ LiveGrade File Edit Project Device View [KITTTI Help

Zoom
Close

Looks Images  Movies
[T Bring All to Front
14.0715

“" Lens Correction Controls NS
-to-Vi 140716 & >xy Default
Sample Looks 14,0716 ¥ LiveGrade

[ ] ARRI Alexa ACES Default
S

The lens correction control window opens.

Q Lens Correction Controls

Shading Correction
Distortion Correction

Distortion Zoom:

Sensor Information:

Sensor Width [mm]: 23,76

Lens Communication:

From top to bottom it contains the following elements:

= Shading Correction:
The checkbox enables / disables the shading correction applied in the image viewer

= Distortion Correction:
The checkbox enables / disables the distortion correction applied in the image viewer

= Distortion Zoom:
Sets the zoom level to balance possible visible image borders when applying the distortion correction

= Sensor Information:
Depending on the recording camera and format the active sensor width differs. The active sensor
width in mm is necessary to correctly calculate the lens correction. Please take a look at the detailed
camera specs to learn more about the sensor width for your specific recording format.



21

= Lens Communication:
If the lens is connected correctly, this section displays the live information that is coming from the
lens including TC, Focus, Aperture and detailed shading and distortion information. You can see that
the figures are changing when you turn the focus ring or aperture ring on the lens. In case figures do
not change, verify all connections.

Lens Communication:

Shading and distortion correction can independently be enabled or disabled to be applied on the image in
the image viewer.

. £ 2




Extract recorded ZEISS eXtended Data using Pomfort Silverstack

Recorded clip files

I:D DaVinci Resolve
o ] & i C
ilverstack =—
L—
Correct distortion and shading
(image enhancement)

eXtended Data files

External cable

What is Pomfort Silverstack?

Silverstack is a Mac software, developed by Pomfort GmbH, for on-set data management in all kinds of professional
film productions. A broad set of features including copying, playback and reporting enables the user to backup,
preview and prepare movie data right on the film set.

Starting from software version 6.2 of Silverstack XT or Silverstack Lab it is possible to import lens correction data (e.g.
from MasterLockitPlus), export it (e.g. to ZEISS plug-in or DaVinci Resolve), and use it for image filtering (XT only).

Install Pomfort Silverstack
= Download Silverstack (http://pomfort.com/silverstack/download/)

= Copy Silverstack to your applications folder and start it.
= Activate Silverstack (license):
= Open the License Manager by choosing Licenses... from the Silverstack menu.
Silverstack... = Licenses...
= (lick on Add License... in the opening License Manager.
= Type or copy / paste a valid license key.
= (Click on Activate License.

License can be ordered from Pomfort web site.
In order to activate the license, the computer must have access to internet.

Extract ZEISS eXtended Data from the MasterLockitP/us with Pomfort Silverstack

Load your camera clips in the Silverstack library and save your clips

Silverstack allows you to read out the corresponding ZEISS eXtended Data from the MasterLockitPlus for each clip
and to save it as a zlcf file. This zIcf file is required for the ZEISS OFX plug-in in DaVinci Resolve. We will tell you how
you get the zlcf files in the next steps.

First you have to register your clips in the Silverstack ‘library’. For doing that there are two possibilities:
» Offload all clips

= Offload = choose your media (SD, SxS Card, Compact Flash Card, ...)

]

BB Library

Il choose Folder

B rozomua PROJECT OVERVIEW

2 Project Name: My Test Project

=

= Choose a destination path where the camera clips should be saved. - Offload


http://pomfort.com/silverstack/download/

eve Offload Clips

Previous Settings* o]

o AO20R1U4 ARl Alex

with 2 clips (and 1 sidecar file, 1 document

+ A Path wildcards Cascading Copy More Options.

= All clips are then listed in the ‘Library’ (left panel) and saved under the destination path witch you
have chosen.

e Add all recorded clips to Silverstack library
= File > Add to Library...

& Silverstack Lab [EI Ecit View Clip Look Playback Window Help
S -

Offiad Q
Add to Library.. . =1 My Test Project &

Export Library Folder...
Project Settings

Import
Export

Cont My Test Project

New Bin...
New Folder..

New Project..

New Smart Folder...

Backup...

Backup to LTFS...

Relink...

Verify...
B Registered today P u <
B Flagged Transcode to Single Clip...
= Custom Look

& Unregister...
B8 volumes Unregister Current Project...

Create Report...

= Choose all clip files from the appropriate media (SSD, SD, ...).
= All clips are then listed in the ‘Library’ (left panel).

Please note:

If you use Add to Library..., the clips are not saved on your computer. You should save your clips on the computer
using the Offload function in Silverstack (as described before) or in another way.

Add to Library... allows you to quickly execute all further steps without waiting while the offload is finished.
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Importing corresponding ZEISS eXtended Data out from the MasterLockitPlus
Choose Import - MasterLockit Plus (CP.3 XD Lens Data)

BN Library W AO20R1
D Silverstack Library Archive (psla)

A020C002.171009 R1U B pomort Looks (ot
% A020R1U4 MaCintC & Match Pomfort Look Archive (pfla)

25 E MovieSlate XML
12 sec B
[B) Qrake XML
1 file with 2 backups B MasterLockit Plus (CP.3 XD Lens Data) |\

v Library Edit Decision List (CMX 3600 EDL)
B A020R1U4 2
> B8 Smart Folders Transcoded Clips

B Volumes

= All data sets corresponding to clips in the library are listed in ‘black’. Data set that do not match with any clip
are greyed out.

Import CP.3 XD Lens Data from MasterLockit Plus

Wark Only Selected Unmark Selected

C | @Finished fens data import

Master Lockit Address: | masterlockitlocal

First Lons Data  Last Lens Data Lens Info

A020C002 171... 0910.17,18:38 16:38:29.01 16:38:29.01  16:38:39.10 Compact Prime CP.3 35/T2.1, Carl Zeis...

A020C001.171... 091017, 18:38 16:38:05.08 16:38:05.08  16:38:15.21 Compact Prime CP.3 35/T2.1, Carl Zels...

Matching 2 of 2 clips.
Import Options.
1 Overwrite "Lens" information of clip.

Sensor Width: mm (based on Camera Info)

Apply Lens Datay)

= Choose all data sets that need to be transferred.

Generating ZEISS eXtended Data files for each clip, which can be transferred to post-production departments
Click Export = ZEISS Lens Correction Files (ZLCF) and choose a directory for ZEISS eXtended Data files.

B N EE

port

B Library @ A020R1U4 (2 docu
E Silverstack Library Archive (psla)..

A020C002_1710C m Pomfort XML Metadata (XML).
% A020R1U4, ’\ Final Cut Pro 7 (XML)

25 12 Final Cut Pro X (XML)...

sec D
Adobe Premiere Pro (XML).
1 file with 2 backi E Avid Media Composer (ALE)...
VB8 Library Assimilate Scratch (ALE).
[ Ao20R1U4

> [ Smart Folders
& Volumes B Redcine~X (Lua)...

@ DaVinci Resolve Export...
1 Clips

Speedgrade/FrameCycler (IRCP).

=
ZEISS Lens Correction Files (ZLCF)... b



0ce

Silverstack generates a list of files named *.zIcf.
These files must be copied and transferred to the PC / Mac on which post-production will happen.
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Distortion and shading correction in Blackmagic Design DaVinci Resolve
with ZEISS plug-in

To use the zlcf-files in Blackmagic Design DaVinci Resolve, ZEISS provides an eXtended Data plug-in.
This plug-in can be downloaded from https://www.zeiss.de/camera-lenses/service/download-center.htm|
On this website you also find a user manual about how to use the OFX-plug-in in DaVinci Resolve for distortion and

shading correction.


https://www.zeiss.de/camera-lenses/service/download-center.html

Appendix
= |ens data cable
= MLC-CP

= Power cables
= AK-XLR4AM

_AEHIX-MY

= AK-HS4-PC2M
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= Camera metadata cables
= MLC-L1B10P

= ACN-RCP

=  Timecode cables
=  TC-I/O & TC-I/0 RA (Right Angle)
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